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FYYRZE Optimetrics: Examplec ©1as-com

* The Shorted Probe-Fed Patch Antenna with Optimetrics

This example is intended to show users how to set up a parametric study, optimize, and simulate the Analytic derivatives of a probe
feed patch antenna using the ANSYS HFSS Environment

A parametric sweep will be used to determine the effect on the input impedance match as a function of the feed pin position
This parametric sweep will be used to seed an optimization analysis that will be used to find the optimal position for the feed pin
Analytic derivatives will also be used to perform real time tuning of several dimensions of the patch antenna

‘
Patch_length \ ' \

10 mm
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ANSYS HFSS: Cotting Sartag >-com

* Launching ANSYS Electronics Desktop 2015

®* To access ANSYS Electronics Desktop, click the Microsoft Start button,
— Select Programs > ANSYS Electromagnetics > ANSYS Electromagnetics Suite 16.0. Select ANSYS Electronics Desktop 2015

* Setting Tool Options
* Note: In order to follow the steps outlined in this example, verify that the following tool options are set:
* Select the menu item Tools > Options > HFSS Options...
— Click the General tab
e Use Wizards for data input when creating new boundaries: ¥ Checked
e Duplicate boundaries/mesh operations with geometry: M Checked
— Click the OK button
* Select the menu item Tools > Options > 3D Modeler Options....
— Click the Operation tab
e Select last command on object select: M Checked
— Click the Display tab
* Set default transparency to 0.7
— Click the Drawing tab
* Edit properties of new primitives: M Checked
— Click the OK button
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WSSl Open Project

* Opening a Project
® Inthe ANSYS Electronics Desktop, select the menu item File > Open
— Browse to the folder containing the file Optimetrics_Patch_Training.aedt and select Open

Z
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INYS'Al Design Variables

* Checking Design Variables

* Two design variables have been created that control the location of the feed of the patch antenna, feed_pos, and the length of the
patch, patch_length

* Toview a list of any design variables that have been created for this design:

Go to the menu item HFSS > Design Properties

* Alternatively, click on HFSSModell in the Project Manger Window, the design variables will be displayed in the Properties
Window

Verify that the variable feed_pos is assigned the value 11 mm
Verify that the variable patch_length is assigned the value 41.6mm
Press the OK button

- - =
Properties: Optimetrics_Patch_Training - HFS5Designl - @
Local Variables |
& Value " Optimization ™ Tuning " Sensitivity " Statistics
Name | Value | Linit ‘l Evaluated Value Type Description Read-only Hidden Sweep
feed_pos 1 mm 11mm Design — IO I
patch_length (416 mm 41.6mm | Design | O i | 2
: [¥ Show Hidden
Add.. Add Aray... Edi... Femove |
feed_pos
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* Parametric Sweep of Feed Position

Parametric Anvgw\é\fscggpup

tennas.com

* We will now complete the creation of the parametric project using the defined variable to vary the coaxial feed position in order to

achieve optimal match between the patch antenna and its coaxial feed line. The ratio of the coaxial feed inner and outer diameters

was chosen to achieve a 50 Ohm characteristic impedance. So we will effectively change the value of the feed offset until we find a
position which presents a 50 Ohm load impedance on the coaxial feed line. The S11 vs. frequency plot has a dip at the patch

resonant frequency, the dip is maximized when the optimal offset is found.

* Create Parametric Sweep
* Select the menu item HFSS > Optimetrics Analysis > Add Parametric...

— Click the Add... button in the Setup Sweep Analysis window
* Inthe Add/Edit Sweep window:

Select the variable feed_pos
Select Linear Step

Start: 9mm

Stop: 12Zmm

Step: Imm

Click the Add>> button

Click the OK button

— Click the OK button

www.chantennas.com
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Add/Edit Sweep

Variable |feed_pos

= Single value

Linear step

Decade count

&
|  Linear count
-
" Octave count
~

Exponential count

Start: |9 |mm j
Shop: |12 |mm ﬂ
Shep: |1 |mm j

=

W ariable

Dezcription

Add x>

| [f

feed_poz Linear Step from Srom to 12mm, step=Tmm

o]

Cancel
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INYSNAE Analysis Configuration

Mis Configuration @

Configuration name: | Local

I [ Use Automatic Settings I

* High Performance Computing Configuration

Parametric sweeps can be accelerated by solving multiple variations in
parallel. The HPC Analysis Configuration will allow us to specify the number
of cores and the number of tasks we would like to run. The number of tasks
will correspond to the number of parametric variations or frequency points
to runin parallel.

e Configuring HPC Settings

From the Analysis Options Toolbar, select Local configuration
Click the Edit Active Analysis Configuration button
Analysis Options Toolbar

i |Local d 18] =

Selected Analysis Configuration Edit Active Analysis Configuration

In the Analysis Configuation window, change the following:

Machines | Job Distabution | Options |
Machines for Distributed Analysis
Total Enabled Tasks: 2 Total Enabled Cores: 4

Name § Tasks | Cores | RAM Limit (%) | Enabled |
localhost |2 4 80 [vw

Ik

Machine Details:

% Local machine

" |P Address format: 192.168.1.2): |

" DMS Mame format: www server.com): |

" UNC Mame format: “\server): |

Import Machines from File... Add Machine to List

oK | Cancel

Uncheck Use Automatic Settings

Tasks: 2

Cores: 4

— RAM Limit(%): 80

Click the OK button to finish and close configuration window

* Analyze Parametric Sweep

In the Project Manager window, select Optimetrics > ParametricSetupl
right click and select Ana
WW
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Note: Additional machines can be added to the
configuration to further accelerate solutions. Each
machine can be used to solve 1 or more task. If an
analysis does not contain a parametric sweep, the
solution will distribute frequency points if a frequency
sweep has been specified.
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* Create S-Parameter plot

Solution: Setupl:Sweepl
Domain: Sweep

In the Trace tab

* (Category: S Parameter
* Quantity: S(P1,P1)

* Function: dB

Click the Families tab

t\évww.cnantennas.com

Select the menu item HFSS > Results > Create Modal Solution Data Report > Rectangular Plot

* Make sure the Value for variable feed_pos is selected to All

Click New Report button
* Click Close button

|
B Report: Optimetrics_Patch_Training - HFSSDesign] - New Report - Neéw Trace(s) [ | | EJ Report: Optimetrics_Patch_Training - HFSSDesignl - New Report - New Trace(s) (=25
Emid Trace | Familiss ] Families Display] | Context——— B | Trace  Families | Familiss Displa',']
Solution: ' S Solution: I L 5
olten Setupl: Sweepl s Primary Sweep: |Freq ﬂ |A|| _J | S EnL: SE S = Families : 4 available
Domain: - - Fre—a l - i+ Sweeps Available variations
omain Sweep ¥ ¥ Default IFreq _‘ omain Sweep | |
1 Variable 1 Value | Edit |
. Range
i |dB(5(P1,P1)) Function... eredjos Al
Category: Quantity: = Function:
Variables - l<none> .
Qutput Variables ang_deg
ang_rad
' Parameter = arg E
Z Parameter 3 cang_deg
VSWR cang_rad
Gamma
Port Zo dB 10normalize
Lambda dB20normalize
Update Report ; = Update Report
Epsilon dBc MNominals: |patch_|engﬁ1 ﬂ
[ Real time Group Delay i Clalla ¥ Real time
Qutput Variables. .. | OgﬁonsWWW [@\'ﬁ@.hte n nas Cbl I l Close Qutput Variables. .. | Options. .. | New Report | | | Cloze
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IVl Results

WWW.Chantennas.com

XY Plot 1 HFSSDesign1
0.00 —
: Curve Info
- | — dB(S(P1,P1})
5.00 Setup1 : Sweep1
E feed_pos="8mm’
] — dB(S(P1,P1})
| Setup1 : Sweep1
feed_pos="10mm"
7 — dB(S(P1,P1})
-10.00 — Setup1 : Sweep1
| feed_pos="11mm"
| — dB(S(P1,P1})
Setup1 : Sweep1
= - feed_pos="12mm"
E_ _
E,;—15.UU —
u _
m
b= .
-20.00 —
-25.00 — u
00 15 | | | | | | | 1'||"EI | | | 1 i|30 1 é!ﬂ | | | 2.00
*wvww.cnanteniias.com | Freq[GHA] | | |
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e Optimization

* The Parametric Sweep was useful for generating design curves. For this simple design with only a single variable we could use the
design curves to make educated guesses at performance targets that are not contained in the Parametric Sweep. To demonstrate
this we will target a minimum of less than -20dB for S;; at 1.8GHz for this shorted patch antenna. From the Parametric Sweep
results, we can see that the minimum return loss at 1.8 GHz will be achieved when the variable feed_pos is around 11mm.

* Create an Optimization Setup
* Select the menu item HFSS > Design Properties

— Click the Optimization radio button: Properties: Optirmetrics_Patch_Training - HF55Designl @

* Name: feed_pos

Local Varables |
e Include: M Checked

. " Value {* Dptimization " Tuning (" Sensitivity (" Statistics
*  Min:10 mm
* Max: 12 mm Mame | Include | Mominal Value Min | it | Mz | it |
— Click the OK button feed_pos M | 1mm 10 mm 12 mm
patch_length [ |41.6mm 203 i 624 mm

v Show Hidden
Add.. Add Aray... | r

oK | Cancel Apply

e Add Optimization Setup

* Select the menu item HFSS > Optimetrics Analysis > Add Optimization...

WWWw.chantennas.com
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Setup Optimization
* Inthe Goals tab:
— Optimizer: Pattern Search(Search-based)

— Click the Setup Calculations... button
* Inthe Add/Edit Calculation dialog:

Report Type: Modal Solution Data
Solution: Setupl: Sweepl
Domain: Sweep

Category: S Parameter

Quantity: S(P1,P1)

Function: dB

Click the Add Calculation button
Click the Done button

Click the value under Calc. Range and select Edit...

¢ Click the Edit button

¢ Click the Select values radio button and select 1.8GHz

¢ Click OK button

Condition: <=
Goal =-20
Weight=1

* (Click the Variables tab:

— Select View All Columns in lower right corner: M Checked

— Set Min Step value: 0.01
www.chantennas.com
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ch

tennas.com

sis Setup
Setup Optimization @
Goals | Variables l General ] Optionz |
Optimizer: |F'attem Search{Search-based) j
Mz, No. of terstions: IW
Cost Function:
Solution | Calculation Calc. Range | Condition | Goal | Weight
Setupl : Sweep dB(S(P1.P1)) Freq(1.8GHz) = [-20] [1]

I Setup Calculatiuns...l ] |

Acceptable Cost: |0 Moise: |0.0001

HPC and Analysis Options. . |

[ Show Advanced Cption

B

QK | Cancel

Setup Optimization

'GoalsGeneml ] Options |

(=35

Variable | Cwvemde | Starting Value | Units | Include | Min | Units | e | Units§ Min Step | Units | Max Step | Units
feed_pos [v 11 mm [v 10 mm |12 mm J0.01 mm D9 mm
Set Foeed Variables... | Linear Constraint... | [v View All Columns

oK | Cancel
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IVl Optimization Analysis Setup
Goals ] ‘-fariables Options |

Parametrics Analysis: |Pa|ametric:Setup‘l ﬂ

* Setup Optimization (continued)

* Click the General tab: { Solve the parametric sweep before optimization
— Parametric Analysis: Pa rametricSetupl (" Solve the parametric sweep during optimization

* This parametric analysis that we solved earlier will be used

. . Iv Update design parameters’ value after optimization
to seed the optimization

* Click the OK button to complete the optimization setup

* Analyze Optimization

Setup Optimization @

Cancel
* Inthe Project Manager window, select Optimetrics >
OptimizationSetup1, right click and select Analyze %1 Post Analysis Display =
|OptimizationSetup 1 | Qf Options...
e Optimetrics Results Resul | Profle |
* Right-click on OptimizationSetupl and select View Analysis Result Viswi: [+ Table
" Plat
— In the Result tab, select the radio button for Table
) o : - Evaluatinnl feed_pu:usl Cost J Expart...
— Click the Close button when you are finished viewing the 1 T 11700
results 2 10mm  B3602
3 Tmm 10633
4 T2mm 66,376
Optimal solution occurs at ~10.55mm, depending on the 5 1.8mm | 57.945 Q
points chosen by the optimizer, other values of feed_pos B 101mm | 015708
may satisfy the optimization criteria i 10.55mm |0
a
www.chantennas.com e |
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IVl Results

* Create Reports

* Select the menu item HFSS > Results > Create Modal
Solution Data Report > Rectangular Plot

— Solution: Setupl:Sweepl
— Domain: Sweep
— Inthe Trace tab

* (Category: S Parameter

KX Report: Optimetrics_Patch_Training - HFSSDesignl - Mew Report - New Trace(s)

Context "Trace Families | Families Display]

Solution: |53b-'l31 : Sweepl j Families : 1 available

Domain: |Sweep j (* Sweeps { Available variations
Variable Value

oo |

feed_pos|10.55mm

WWW.cnantennas.com e

=5

Edit |
- " Use all values

* Selectvalues

d

Smm
10mm

10, Imm

Mominals: | patch_length

Update Report -
[¥ Real time i |

® Quantity: S(Pl,Pl) Select Al Clear Al |
Qutput Variables. .. ‘ Options. .. ‘ Mew Report ‘ ‘ — ~
¢ Function: dB p: (& Defailt ]
— Click the Families tab
. . . XY Plot 2 HFSSDesign1 4
Click the Edit button .
— Click 10.55mm in the pop-up window i
— Close the pop-up window by clicking the X i Curve Info
button i etupt - Swoept
. 7 feed ="10.55mm"
— Click New Report button . B —
— Click Close button =000
T ]
£-15.00 —
& ]
8 ]
-20.00 -
-25.00
www.chantennas.com 20032 —
150 160 170 1.80 1.90 2.00
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IVl Analytic Deriv

* Analytical Derivatives

WWW.Chantennas.com
atives

From the parametric sweep and optimization of the feed position we can see that the optimal position is at about 10.55mm. To
further investigate or an alternative to the optimization, we could use analytical derivatives to predict the behavior of our model

with respect to small changes in design variables.

* Enable Analytic Derivatives

* Analyze

14

Right click on Setupl in Project Manager Window and select Properties...

— Select Derivatives Tab

+ feed_pos: Use M Checked
e patch_length: Use M Checked

— Click the OK button

i

Driven Solution Setup

Produce Dervatives for these variables

Generml l Options i Advanced I Expression Cache - Denvatives i Defaults I

[l

Mame

feed_pos
patch_length

=za
m
[v

o |

Cancel

Select the menu item HFSS > Analyze All

www.cnhantennas.com
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Project Manager

=Bl optimetrics_Patch_Training
£1-## HFSSDesign1 (DrivenModal)

.g: 30 Componernts
----- & Model

H-EF Boundaries
- Excitations

----- B Mesh Operations
£ Analysis

[]..._@ Optimetrics Copy Ctrl+C
#-[F] Results Paste Ctrl+V
&[] Port Field Dis
..... ﬁ Field Overlay Rename F2
[]...';' Radiation | 3 Delete oz
@[] Definitions
Properties...
Dizable Setup

Add Frequency Sweep...
Add Dependent Solve Setup...

Analyze
Revert to Initial Mesh
Apply Mesh Operations

Clear Linked Data

Create Quick Report...
Perform FFT on Report ...
Perform TDR on Report ...

Profile...
Convergence...
Matrix Data
Mesh Statistics...

Network Data Explorer...
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IWYSSE Creating a Tuning p

* Create Nominal Plot for Comparison
* Select the menu item HFSS > Results > Create Modal Solution Data Report> Rectangular Plot

Solution: Setupl: Sweepl

Domain: Sweep

Derivative: <none>

In the Trace tab

* (Category: S Parameter

* Quantity: S(P1,P1)

* Function: dB

Click the Families tab

*  Click the Edit button
— Click 10.55mm in the pop-up window
— Close the pop-up window by

clicking the X button
Click the New Report button

* Continued on Next Page

15
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Context

Solution: |5.31-|_|p1 : Sweep1

=
Domain: |Sweep ﬂ
=

Derivative: |<none:=

_roncpor- gl

~Update Repart — R
I IV Healfimel Updsi= &

Qutput Variables. .. | Ogtinns...|

EY Report: Optimetrics_Patch_Training - HFSSDesignl - New Report - New Trace(s)

Llf_@

Trace | Families | Families Display |

Primary Sweep: |FFECI j |"5'"

X v Default |=-'5:

Y: d&(S(P1,F1)) l%jgcggnn...

Category: Quantity: & Function:

Variables - <none -

Qutput Variables ang_deqg
ang_rad

¥ Parameter - arg =

Z Parameter 3 cang_deg

WSWR L | cang_rad

Gamma

Port Zo dB 10narmalize

Lambda dB20normalize

Epsilon dBc &

Group Delay - 4w ] »

Mew Report | | |

Close
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Create Tuning Plot

In the Create Rectangular Plot Report, change the Derivative option

Solution: Setupl: Sweepl
Domain: Sweep

Derivative: All

In the Trace tab

* (Category: Tune S Parameter
* Quantity: Tune S(P1,P1,All)
* Function: dB

Click the Add Trace button

Click the Close button

www.chantennas.com
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"

E Report: Optimetrics_Patch_Training - HF55Designl - XY Plot 3 - dB{S(P1,P1]))

—Context
Solution: |Setup 1: Sweepl ;J
Domain: |Sweep ;ﬂ

Derivative: |AII

s

—Update Report——

|
v Real time

Output Variables. .. ‘ Dgtinns...|

Trace | Families I Families Display ]

[l
-
=

Primary Sweep: IFreq j |-'5-||
X: v Default |=-'e:
) Range

¥: |dB(Tunes (P 1,P1,AI) S
Category: Quantity: b Function:
Variables _ <none -
Cutput Variables ang_deg

n ang_rad
Tune ¥ Parameter arg =
Tune Z Parameter cang_deg
Tune Gamma cang_rad 5

Tune Port Zo
Design

dB 10normalize

dB20normalize

dBc e
€| m 3

Mew F‘.epnrt| Apply Trace | &ddTrau:E|

Close
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IV Tuning Plot

* Tuning Plot

* Select the menu item HFSS > Results > Tune Reports ...

Move the scroll bars in the Report Tuning window to predict the performance for various patch width and feed position values

* Click the Close button XY Plot 3 HFSSDesignt 4
0.00
b Curve Info
1 E --- dB(S(P1.P1))
5.00 * Setup1 : Sweep1
i LY feed_pos="10.55mm’
| —— dB(TuneS(P1,P1,A1})
Setup1 : Sweep1
1 feed_pos="10.56mm"
10,00 | Report Tuning &3
B Offsets
A ﬂ ﬂ Apply offsets to
i feed_pos patch_length nominal design
i 10.55mm 41.6mm B —— 1
—-15.00 — 5 1
= i | | L |4' e Save all offsets i
J E = L
_ | BN
i Close 1
-20.00 | —I_‘ -I_| o e I
i Ly
1
g |'|43.1399 [“0.5824 l o
[
_ -1.055 416 L
Ly
-25.00 < iy
1 b
J [
-30.00 T T T T T T T T T T T T T T T T T T T T T T T T
1.50 1.60 170 1.80 1.90 2.00

Freq [GHz]

Note: The predicted response is based off the nominal solution and partial derivative that was computed during the solution process.
Analytic Derivatives could have been used before any optimization to more quickly narrow the solution space by testing how

indidd\/al pdraniete tEwill afiest e lantenna performance.
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